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1 Welcome and
Registration

1.1 About Works Better

Welcome to Works Better, an enhancement for Newton Works. It adds many new
features to the Newton’s basic word processor, including headers/footers, columns,
and complete style options. It also includes a handwriting recognition feature, so
you can write or type text into Newton Works. This manual goes through each of
the enhanced features, and is not intended to cover every aspect of Newton Works,
and only discusses the enhancements included with Works Better. If you have any
questions about the basic functions of the word processing application, please
refer to the manual that came with Newton Works. To use Works Better, just open
Newton Works as you normally would, and Works Better automatically activates
to enhance the basic Newton Works features.

Included in this archive are the following packages:

•Works Better.pkg
  This is the software package that you need to install on
  your Newton

•Works Better.pdf
  This is the users’ manual for Works Better. You are reading it right now.

•Works Better.txt
 This is a text only format of the users’ manual. If at all possible, use
 the pdf version of the manual as it has layout and graphics that cannot
 be included in the text version. The pdf version of the manual is
 viewed using Adobe® Acrobat Reader®. This can be obtained free of
 charge at www.adobe.com.

•SAStuff.txt
 A list of all of the software available from Stand Alone Inc.

•SA reg.pkg
 If there isn’t a registration option under the  button, install this
 package to register your software.
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1.2 System Requirements

Works Better requires Newton OS 2.1, and a Message Pad 2000, or an eMate. It
also requres Newton Works to be installed on the machine. If Newton Works is
frozen, Works Better will not run. However, you can keep Newton Works frozen
until you want to use it.

1.3 Registering Works Better

The Works Better Demo will work for a 30 day trial period. At the end of the 30
Days, it will stop working. To avert this tragedy, you will need to get in touch with
Stand Alone to register your software. You can register with us by several different
methods.

You will need to include the following information, no matter how you choose to
register. Most importantly, you need to include your name EXACTLY as it is
entered in your Newton, including spaces. We use this to generate your password,
so it must be precise. You will need to specify which programs you wish to regis-
ter, and include payment for each of them. We accept Visa, Mastercard, and Ameri-
can Express. If you are using normal mail, you can send us a check as well. Make
sure to include your card number, the expiration date, and what type of card you
are using. You also need to give us a way to get in touch with you. Email is the
preferred way, followed by your address and phone number. An Email address is
not strictly necessary, but it will result in much faster service.

For instant gratification, register by phone, and pay using Visa or Mastercard. To
do so, call (773) 477-2492 and we will give you a password right over the phone.

Alternatively, you can send us a check to the address below.

You can also Email us one of several ways. The application has a Register section
under the  button. Tap on that to open up a registration slip. If you fill out that
slip, and have an Email client on your Newton, it will automatically Email us and
we will send you a registration code. You could also just Email us the relevant
information from your Newton or a desktop machine, and we’ll send you a code. If
you are registering through Compuserve, use, GO SWREG.

Once you register, you will receive a password from us. You can install this pass-
word one of two ways. There is an option to Enter Password under the  menu.
Tap on it to bring up a screen that has a space to enter the password. Alternatively,
just install the SA Register package enclosed in the Works Better archive. Select
“Works Better” from the pop-up menu at the top, and enter the password. You
should get a message confirming the password. Afterwards, you may remove the
SAS Register application from you Newton.
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1.4 Contacting Stand Alone Inc.

There are several ways to get in touch with us here at Stand Alone, Inc.  Email is
the preferred form of communication, but whatever works for you is fine. If you
have any questions, comments, suggestions or compliments, please don't hesitate
to contact us through any of the methods listed below.

1.4.1 Business Hours
Stand Alone is open from 9 AM to 9 PM Monday to Friday, and 10 AM to 4 PM
Saturday and Sunday. These times are CST and GMT -5.

1.4.2 Email:
internet: info@standalone.com
AOL: Std Alone
CompuServe: 76342,3057

1.4.3 Phone:
Voice: (773) 477-2492
Fax: (773) 477-2579

1.4.4 Regular Mail:
Stand Alone
3171 N. Hudson, Suite 1
Chicago, IL, 60657, USA

1.4.5 World Wide Web:
http://www.standalone.com

1.5 Reporting Bugs

If you find a bug in our software, it would be helpful if you reported the bug to us.
To report a bug, please Email us with Bug Report Request in the subject line.  In
the Email, include the following information:

•What type of Newton you are using (i.e. MP 2000)
•The version number of the system software (i.e. Newton OS 2.1)
•The software name and version number (i.e. Works Better 1.03)
•The error number
•A brief description of how we can recreate the error
•Your name and Email address so we can contact you when the bug is fixed
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When reporting bugs, it is best to Email us, rather than calling, so that the pro-
gramers have a written record of the information they need to solve the problem.
As soon as we receive your Email, the programer will examine the problem, and
fix it.. Because our programers are busy creating software, it can take a while for
them to reply, but they will release a new version of the software that fixes the bug
as soon as they can.

1.6 Version History

Version Date Notes

1.2 June 7, 1997 Minor bug fixes, expanded prefs
1.0 April 26, 1997 First public release
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2 Installation
The first thing that you need to do to get your software up and running is to
install it on your Newton. To do this, you need to have Newton Backup Utility, or
Newton Connection Utilites, set up to talk to your Newton. If you have problems
with this part of the installation, pleast contact  consult the documentation that
came with your Newton. Once Newton Backup Utility is set up, just follow the
steps listed below to for each of the packages you wish to install.

1. Open the Newton Backup Utility , or Newton Connection Utilties

 on your Desktop machine.

2. On your Newton, go to the Extras Drawer and tap the Connection icon

.

3. Once the Newton Backup Utility has loaded on your desktop machine, make

sure your cables are connected and tap the  button on your Newton.

4. For each of the packages you wish to install, do the following:

• Tap the Install Package button in the Newton Backup

Utility   

• Go to the folder where your packages are, and select the desired package.

• Click on the “Install” button

StandAlone Inc.
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3 Format Enhancements
Works Better has a number of enhancements for Newton Works. The enhance-
ments are separated by menu, and are explained in the following chapters.

The Format menu is the first menu to be examined. Works Better adds columns,
header and footers, includes page number in the paper, and can define styles for
the entire paper.

3.1 Columns
The Columns screen lets you format a document to include up to four columns.
By tapping the Number of Columns line, you can have between one and four
columns. If you wish the paper to be formatted normally, set the columns choice
to one. The next line controls how much space is placed between the columns.
When using columns in a paper, it is important to realize that the columns will not
be visible on the screen, but will take effect when the document is printed. The
only way to see how the document will look when using columns is to use the
Preview option before printing. Also, before using the Preview function, make
sure that the format is set to Formatted Paper. When printing a document, it is also
necessary to set the format settings to Formatted Paper. Please refer to Section 3.5
for more information on printing.

3.2 Define Styles
You can define the style of text for the entire paper using Define Styles. If you
have a set way that you prefer the fonts, margins, tabs, etc., you just need to create
a style using Define Styles, and select the style whenever you open a new docu-
ment. When Define Styles is tapped, a screen appears with a list of previously

Set number
of columns

Set spacing
between
columns
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defined styles. To choose an old style, just tap on the style name. Styles can be
removed from the list by selecting the style to be removed and tapping the Re-
move button.

To define a new style, tap the Define New Style button. A new window appears
where you define the style.

Saved
styles

Create new
styles

Choose
font

Control
spacing
for inserts

Check to start a
new paragraph
when applying
the style

Choose
font size

Set
justification

Set
spacing

Name
of style

Choose
face

Set
tabs
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3.3 Headers and Footers

This function lets you set a section of text to be printed at the top or bottom of the
pages of the document. The pickers at the top determine the font type, size, and
face. It also gives you the option of showing or not showing the text, and if you
want the information on all the pagers, or just after a certain page. The Insert Item
button at the bottom lets you insert information, such as the current date, time,
page numbers, or total number of pages.

If you use the Insert Item button to add information to a header or footer, a section
of text appears in the header or footer screen. Do not change this text, or the
added information will not appear correctly.

Switch
between
header or
footer

Include
header or
footer in
document

Set
font

Select to insert item into
the header or footer

Where to
start
including
header or
footer

Set
justification

Font
size

Font
face
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3.4 Page Numbers
You can include page number are included in a document in two ways. The first
way is  through a header or footer as described in Section 3.3. Alternatively, you
can use the Page Numbers choice in the Format menu. Page Numbers sets the
font, face, and size, as well as the number’s position on the page. It will also flip
the numbers for facing pages, so, for example, a document with left and right
pages can always have the page number in the lower outside corner. The screen on
the right arranges the number on the page. Place the small shaded box where you
wish the page number to appear.

Include
page
numbers

Choose
font

Choose
font face

Set font
size

Mirror
numbers

Place
numbers
here

Align numbers
to the edge of
the pagex x
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3.5 Special Printing Instructions
To print a document using headers, footers, page numbers, or columns, you need
to set the Format option on the Print screen to Formatted Paper. If you set it to
Formatted Paper, the Preview button will show you how your paper will look
after being printed.

Use this to
view
special
formatting

Make sure to
set Formatted
Paper here
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4 Font Menu Enhancements
Works Better gives a number of new choices in the Fonts menu. It includes a new
font, new font sizes, and subscripts and superscripts. You can also access any of
your defined styles through the Font menu.
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4.1 Instant Style
You can quickly create a new style through the Instant Style screen. It has fewer
options than the Define Styles menu, but it is faster to use. The Instant style is
based on the style at the current position of the caret.

4.2 Character
Character lets you quickly format a block of text. To use it, select the text that you
wish to format, and then choose Character. The Character Settings screen then
appears, where you can format the text.
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Font
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Font
face

Make new
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Font
size
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5 Tools Menu Enhancements
When you bring up the Tools menu, there are several new choices. These include
Go to Page, Import Notes, Key Caps, and Word Count.

5.1 Go to Page
Go to Page lets you jump from page to page within a document. Just write in the
number of the page that you wish to view and tap Go.

Go to page
number

Tap to
view
selected
page
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5.2 Import Notes
You can import notes from the NotePad into the Works program. To move notes
into the Works program, select the note you wish to import from the left screen
and drag it onto the screen to the right. When you have all the notes that you want
to import dragged onto the right screen, tap Import. You may select whether or not
to delete the notes that you are importing from the NotePad. Lastly, you can
rearrange the notes in the import window. Notes are imported into Works in the
order they are listed.

Notes in
NotePad

Delete imported
notes from the
NotePad

Import
notes

Notes to be
imported
to Works
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5.3 Import Email
This function is essentially the same as Import Notes. It uses a similar screen,
except that it imports Email rather than notes. Follow the directions for Import
Notes when using this feature.

5.4 Key Caps
The key caps feature gives you quick access to the more unusual characters of a
keyboard. It shows you what will be entered with a key stroke if Option or Shift
(or both) are held down. It is also a fully functioning keyboard, and anything you
type will appear on the screen at the text caret. The Bold Characters box makes
the font on the keyboard Bold, so it is easier to read.
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5.5 Word Count
Selecting Word Count automatically performs a count for the current document. It
counts characters, words, paragraphs, and pages.

5.6 Handwriting Settings
The Handwriting Setting access the internal handwriting preferences screen of the
Newton OS.



 PreferencesChapter 6 Stand Alone, Inc.

 Page 17Works Better Users’ Manual

6 Preferences
6.1 The  button

Accessing the  menu is slightly different than usual. If you tap the  button

on the main screen you will see the following menu.

Works Better Preferences is the only option that allows you to reach the Prefer-

ences section of Works Better. However, any of the  buttons found in the

Works Better sub-menus directly address the Works Better Preferences. The sub-

menus that have the Works Better  button are: Columns, Define Styles, Head-

ers & Footers, Page Numbers, Go to Page, Key Caps, and Import Notes.

The  menu gives you access to About, Preferences, and Enter Password. About

gives you information on how to contact us, as well as a brief description of
Works Better.

6.2 Preferences
The Preferences Menu lets you customize Works Better

Access Newton
Works preferences

Access Works
Better preferences
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6.2.1 Handwriting Recognition
Checking the Enable Handwriting Recognition box lets you enter text into New-
ton Works with handwriting as well as by keyboard.

6.2.2 Format Menu Preferences.
The next four preferences let you set what options are shown in the Format menu.
This way, you only need to include the options that you use, and can leave out any
features that you don’t want.

6.2.3 Show Lines in Paper
Checking Show lines in paper put lines in the background of the Works Better
document. These lines look identical to lines found in the NotePad.

6.2.4 Tools Menu Preferences
Checking any of the boxes in the section labeled “Show these tools in the ‘Tools’
picker” includes the options in the Tools picker.


